Dell™ PowerVault™ NX1950
Cluster Systems With
Dell|EqualLogic PS Series Storage Array

Installation and Troubleshooting Guide
Notes, Notices, and Cautions

NOTE: A NOTE indicates important information that helps you make better use of your computer.

NOTICE: A NOTICE indicates either potential damage to hardware or loss of data and tells you how to avoid the problem.

CAUTION: A CAUTION indicates a potential for property damage, personal injury, or death.

Information in this document is subject to change without notice.
© 2008 Dell Inc. All rights reserved.

Reproduction in any manner whatsoever without the written permission of Dell Inc. is strictly forbidden.

Trademarks used in this text: CommVault and CommVault Galaxy are registered trademarks of CommVault Systems Inc.; Dell, the DELL logo, PowerVault, are trademarks of Dell Inc.; Microsoft, SQL Server, Windows, Windows Server, MS-DOS are either trademarks or registered trademarks of Microsoft Corporation in the United States and/or other countries.

Other trademarks and trade names may be used in this document to refer to either the entities claiming the marks and names or their products. Dell Inc. disclaims any proprietary interest in trademarks and trade names other than its own.
Contents

1 Overview ........................................ 7
   Using a PS Series SAN as Shared Storage ........ 9

2 Planning the Network Configuration ............. 13
   Considering the Network Design Structure ........ 13
   Planning Network Redundancy .................. 15

3 Setting Up the Cluster ......................... 17
   Pre-Installation Requirements .................. 17
   Installing the Cluster ......................... 17

4 Setting Up the Dell|EqualLogic PS Series SAN .... 21
   Creating the Group ............................ 21
   Configuring Volumes in a PS Series Storage Array ... 22
   Restricting Access to Volumes .................. 25
5 Configuring Shared Storage on Your Dell EqualLogic PS Series Storage Array ................. 29
   Connecting Nodes to Volumes ...................... 29
   Aligning the Disk Sectors ......................... 32
   Configuring a Basic Disk ......................... 32
   Assigning a Drive Letter and Formatting a Partition ......................... 32

6 Setting Up MSCS .................................. 33
   Creating the Cluster ............................... 33
   Modifying the Cluster Network Configuration ................. 34
   Adding a Node to the Cluster ...................... 37
   Modifying Cluster Configuration Options .................. 39
   Testing Cluster Failover ............................ 39

7 Expanding Your SAN Storage ............... 41
   Increasing the Size of a PS Series Volume ................. 41
   Increasing PS Series Group Capacity .................. 43
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>8 Strategies for Backup and Recovery</td>
<td>45</td>
</tr>
<tr>
<td>Protecting Cluster Data</td>
<td>45</td>
</tr>
<tr>
<td>Choosing a Backup Method</td>
<td>46</td>
</tr>
<tr>
<td>Restoring Data</td>
<td>47</td>
</tr>
<tr>
<td>9 Upgrading your SAN and Network</td>
<td>49</td>
</tr>
<tr>
<td>Upgrading Components in Your Cluster</td>
<td>49</td>
</tr>
<tr>
<td>10 Maintaining Your Cluster</td>
<td>51</td>
</tr>
<tr>
<td>Replacing the Quorum Resource</td>
<td>51</td>
</tr>
<tr>
<td>Removing a Node from a Cluster</td>
<td>52</td>
</tr>
<tr>
<td>A Using WSRM and Scripts to Manage Clusters</td>
<td>55</td>
</tr>
<tr>
<td>B Migrating an Existing Cluster to Dell</td>
<td>Equallogic PS Series Storage</td>
</tr>
<tr>
<td>Index</td>
<td>59</td>
</tr>
</tbody>
</table>
Overview

The Dell™ PowerVault™ NX1950 cluster solution with Dell|EqualLogic storage array combines Microsoft® Windows® Unified Data Storage Server 2003 clustering with a highly available and scalable Dell|Equallogic PS Series storage array. Server clusters based on Microsoft® Cluster Service (MSCS) provide availability for applications through failover. The following list summarizes server cluster features:

- Provides features that can be used for databases, e-mail services, line of business (LOB) applications, and custom applications.
- Provides high availability and server consolidation.
- Requires the use of shared storage.

**NOTE:** Throughout this document, PowerVault NX1950 storage system refers to the individual storage unit and PowerVault NX1950 cluster solution refers to the configuration of the storage unit along with the storage arrays.

In a PowerVault NX1950 cluster solution configuration, if the hardware or software fails and causes a service failure, the cluster automatically restarts the failed service on a functional cluster node. This service failover capability ensures that no data is lost, and there is little disruption to users. When the issue is corrected, the cluster can re-balance the services across all functional nodes. The following figure illustrates a service failover on a typical cluster configuration in which all nodes are running different services.

Figure 1-1 shows that Node A fails over to Node B.
Figure 1-1. Node A Fails Over to Node B

NOTE: Although most clustered services run on only one node at a time, a cluster can run many services simultaneously to optimize hardware utilization.
Using a PS Series SAN as Shared Storage

The PS Series storage array overcomes the challenges of DAS and traditional SANs by providing a familiar technology for connecting servers to storage – Ethernet. An iSCSI (Internet SCSI) SAN provides an affordable and easy-to-manage shared storage solution for your cluster nodes. The basis of the SAN is a PS Series storage array, a no-single-point-of-failure storage device that combines reliability and scalability with an easy-to-use management interface for a single system view of the storage connected to an IP network. By grouping together one or more PS Series storage arrays, cluster nodes can be connected to a pool of shared storage that provides:

- **High availability** — PS Series storage array hardware delivers redundant, hot-swappable components like disks, control modules, fans, and power supplies for a no-single-point-of-failure configuration. Components fail over automatically without user intervention or disrupting data availability.

- **Improved data protection** — All data is protected with Redundant Arrays of Independent Disks (RAID) and spare disks. Full component redundancy and hot service capabilities to ensure online operation.

- **Scalability** — With a PS Series storage array, you can easily increase the array capacity by installing additional drives or adding network connections. You can also expand overall PS Series group capacity to terabytes of storage by adding arrays to the group. The new arrays are configured automatically, and the storage pool is expanded. During this process, data remains available with no impact on hosts and applications. You do not have to open the storage array or reconfigure an operating system. The additional storage space is immediately available for use by any application on any server because, in a cluster, all the servers have access to all the shared storage.
• **Easy and inexpensive management** — The PS Series storage array has offers centralized storage which enables you to manage more storage efficiently. You can use a simple setup utility to configure an array on the network and create a PS Series group and a functioning iSCSI SAN. You can easily manage automation of complex operations like RAID configuration, disk sparing, data provisioning, and load balancing to ensure effectively managing the SAN.

• **Advanced management features** — The PS Series comes standard with a comprehensive set of features including automatic load balancing, virtual volume management, space-efficient snapshots for instant backup and restore, volume cloning for rapid server provisioning, multipath I/O support, cluster support, and Auto-Replication capabilities delivering a comprehensive disaster recovery solution.

Each array (member) in a group contributes disk space to the pool, which can store the cluster quorum resource in addition to the data used by the cluster applications. As needed, you allocate portions of the pool to volumes, specifying a size, access controls, and other attributes. The PowerVault NX1950 storage system sees each volume as a single device and each volume is automatically load-balanced across multiple disks and group members as required.

Figure 1-2 shows a cluster configuration with a PS Series group as the shared storage.
Figure 1-2. Cluster Configuration With a PS Series Group as Shared Storage

- **PowerVault NX1950 A**
  - Service 1: Quorum Volume
  - Service 2: service1_data Volume
  - Service 3: service2_data Volume
  - Service 4: service3_data Volume
  - Service 5: Test Volume

- **PowerVault NX1950 B**

- **PowerVault NX1950 C**

**SAN network**

- **PS Series Array Shared Storage**

- **Public network**
Planning the Network Configuration

The following sections provide different possible network configurations and help you plan for the implementation of Dell™ PowerVault™ NX1950 cluster solution with Dell|EqualLogic PS Series storage.

Considering the Network Design Structure

Implementing the correct networking infrastructure is essential to trouble-free operation of your PowerVault NX1950 cluster solution. This section provides guidelines for designing networks for use with a cluster. Typically you have a minimum of three networks in use:

- **One or more data networks for applications**— These are referred to as public networks. A data network can be made redundant using Network Interface Card (NIC) teaming or by using multiple interfaces on separate subnets.

- **Heartbeat network**— This is referred to as a private network. NIC teaming cannot be used on the heartbeat network.

- **Storage area network (SAN)**— The SAN can be made redundant by use of Microsoft’s multipath I/O (MPIO). Multipath I/O provides more intelligent, SAN-integrated load balancing capabilities.
The following SAN network guidelines are recommended for optimal performance and high availability:

- **Use a switched, Gigabit Ethernet network.**
  Connect storage arrays and hosts to a switched network and ensure that all network connections between hosts and arrays are Gigabit Ethernet. An array can operate at 10 and 100 Mbits, but performance is significantly degraded.

- **Utilize fast convergence/fast spanning tree.**
  The Spanning Tree Protocol (STP) has a measurable convergence time. When a switch participating in spanning tree fails, the protocol needs to recalculate which is going to be the root switch. During this time, you can experience a network service interruption on that segment while this re-convergence happens. Rapid Spanning Tree Protocol (RSTP) allows a switch port to bypass the Spanning Tree listening and learning states and quickly enter the STP forwarding state. Utilizing Rapid Spanning Tree Protocol (RSTP, 802.1w) can speed up the time it takes to recalculate spanning tree, thus reducing network service interruption. To verify if your switches are RSTP-capable and how to configure for RSTP, see your switch documentation.

- **Use flow control.**
  Enable Flow Control on each switch port that handles iSCSI traffic. Enable Flow Control on the NICs to obtain any performance benefit. PS Series storage arrays support Flow Control.

- **Enable Jumbo Frames.**
  If supported by all the devices in the network path between hosts and arrays, enable Jumbo Frames on each switch that handles iSCSI traffic. This support is usually disabled by default. Also enable Jumbo Frames on the NICs that are responsible for iSCSI traffic to obtain any performance benefit and ensure consistent behavior.
• Configure multiple network interfaces on an array.
  Connect the network interfaces to different switches.

• For a multi-subnet PS Series group, provide access to the subnet on which the
group IP address for all enabled network interfaces on the group members.

• Use redundant paths between iSCSI initiators and storage arrays.
  Multipath I/O ensures that no single point of failure exists between initiators
  and arrays. This can be achieved by using Microsoft’s MPIO solution.

For additional details on these guidelines, see the EqualLogic Customer
Support website at www.equallogic.com. You must create an account to
access contents of the EqualLogic Customer Support website.

Planning Network Redundancy

You must make the network fault tolerant like you make your applications
fault tolerant by deploying clusters. You have to apply certain rules when
configuring redundancy for the different network segments of your cluster as
described in "Considering the Network Design Structure" on page 13. The
public network can be made redundant using NIC teaming or by configuring
multiple interfaces on separate subnets. The network that is enabled for
internal communication between cluster nodes, typically a private network,
must not be teamed. The SAN network should use multipath I/O for
redundancy.

When used with a PS Series group, full cluster redundancy at the network
level may require five network ports. You can accomplish network redundancy
in the PowerVault NX1950 cluster solution by using the following:

• Teaming or multiple interfaces on separate subnets. These are the only two
  supported options for the public network. For more information on
  network adapters and drivers required for teaming to a specific
  environment, see your network adapter documentation.

• Two or more NICs for SAN traffic, utilizing multipath I/O. NIC teaming
  for iSCSI is not supported.

• One NIC for the private internal cluster communications or heartbeat. As
  a best practice, ensure that the network adapters used in all cluster nodes
  are identical. Whether using the PowerVault NX1950 storage system on-
  board (built-in) network adapters or add-on PCI/X cards, they should be
  the same make, model, and firmware version on each network.
The following table shows an example of planning IP addresses for a cluster.

### Table 2-1. Cluster Name and IP Assignment

<table>
<thead>
<tr>
<th>Interface</th>
<th>IP Address</th>
<th>Subnet Mask</th>
<th>Gateway</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Node A</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SAN</td>
<td>192.168.0.11</td>
<td>255.255.255.0</td>
<td>Gateway optional</td>
<td>Using MPIO</td>
</tr>
<tr>
<td>SAN</td>
<td>192.168.0.12</td>
<td>255.255.255.0</td>
<td>Gateway optional</td>
<td>Using MPIO</td>
</tr>
<tr>
<td>Public</td>
<td>172.16.100.212</td>
<td>255.255.255.0</td>
<td>172.16.12.1</td>
<td>Teamed/virtual values</td>
</tr>
<tr>
<td>Private</td>
<td>10.10.10.1</td>
<td>255.255.255.0</td>
<td>N/A</td>
<td>Do not assign gateway</td>
</tr>
<tr>
<td><strong>Node B</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SAN</td>
<td>192.168.0.13</td>
<td>255.255.255.0</td>
<td>Gateway optional</td>
<td>Using MPIO</td>
</tr>
<tr>
<td>SAN</td>
<td>192.168.0.14</td>
<td>255.255.255.0</td>
<td>Gateway optional</td>
<td>Using MPIO</td>
</tr>
<tr>
<td>Public</td>
<td>172.16.100.222</td>
<td>255.255.255.0</td>
<td>172.16.12.1</td>
<td>Teamed/virtual values</td>
</tr>
<tr>
<td>Private</td>
<td>10.10.10.2</td>
<td>255.255.255.0</td>
<td>N/A</td>
<td>Do not assign gateway</td>
</tr>
<tr>
<td><strong>Cluster</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Short Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>cluster0</td>
<td>172.16.100.10</td>
<td></td>
<td>cluster0.acme.com</td>
<td>Cluster configuration</td>
</tr>
</tbody>
</table>
Setting Up the Cluster

This section outlines the basic steps required to configure a Dell|EqualLogic PS Series SAN as the shared storage for a Microsoft® Windows® Unified Data Storage Server 2003 cluster. The steps assume that you have already completed the hardware installation and setup of your group as described in the PS Series QuickStart.

Because you are using a shared storage device, when you turn on the system and start up the operating system, it is vitally important that only one node has access to a shared volume at one time. Otherwise the shared volumes can become corrupted. After the cluster service is running properly on one node, you can add and configure the other nodes.

Pre-Installation Requirements

Ensure that all nodes are installed with the following:

1. Microsoft Windows Unified Data Storage Server 2003 Enterprise Service Pack 2 or later
2. Microsoft iSCSI Software Initiator
3. Required number of NICs

**NOTE:** You require multiple NICs for the cluster configuration. For more information, see the Installation Guide.

Installing the Cluster

1. Configure MPIO on each node using the Remote Setup Wizard.

   Start→ Equallogic→ Remote Setup Wizard and select Configure MPIO settings on this computer.

2. Add the Persistent Reservation Key MSiSCSI DSM to each node in the cluster:
   a. Select an 8-byte value that is unique to that cluster.
   b. Locate the following registry key at: HKLM\System\CurrentControlSet\Services\MSiSCDSM\Persistent Reservation.
c Add the following values: \texttt{UsePersistentReservation REG\_DWORD}

\texttt{d Setting this value to 1 enables Persistent Reservation. PersistentReservation Key REG\_BINARY <PR key>}. This is an 8-byte binary value that is unique to the cluster. The same binary value must be used on all nodes in the cluster.

3 Set the disk time out to 60.

Set the value of \texttt{HKEY\_LOCAL\_MACHINE\\SYSTEM\CurrentControlSet\Services\disk\TimeOutValue} to 60 seconds.

4 Set recovery of the iSCSI service:

\begin{enumerate}
\item Select \texttt{Start}→\texttt{Run} and type \texttt{Services.msc}.
\item Double click on the \texttt{MS iSCSI initiator services}.
\item Select \texttt{Recovery} tab for directions to start recovery if the initiator service fails.
\item Select \texttt{Restart the Service} for all three scenarios.
\item Set the \texttt{Restart service after} value to 0.
\end{enumerate}

5 From the first node, set up a PS Series group and create the volumes required for the cluster environment.

Create the following volumes:

\begin{itemize}
\item Quorum resource volume. Microsoft requires that you configure the quorum disk with a size of 512 MB.
\item Volumes for service data, as needed.
\end{itemize}

Ensure that you have created one or more access control records for each data volume to allow only the cluster nodes access to the volume. In addition, reserve Snapshot space for each volume if you want to create volume snapshots or use Auto-Snapshot Manager for VSS backups. For more information, see "Setting Up the Dell|EqualLogic PS Series SAN" on page 21.

6 Optimize the SAN network for performance.

For more information, see the EqualLogic Technical Report \textit{Network Connection and Performance Guidelines}. 

---

18 Setting Up the Cluster
7 On the first node, use the iSCSI initiator to connect to the shared volumes and format the volumes.
   a Start the iSCSI initiator and log in to the iSCSI targets associated with the volumes you set up in step 1. Use the group IP address as the target portal or discovery address.
   b Ensure that you have established a persistent connection to the volume and bound the volume so it is available when needed. After establishing the connection, the volumes appear as disks in the Disk Management utility.
   c Align the disks sectors, configure each iSCSI disk as a basic disk, and assign a drive letter. For more information, see "Configuring Shared Storage on Your Dell|EqualLogic PS Series Storage Array" on page 29.

8 Allocate static IP addresses on your public network.
   You require an IP address for the cluster. These are the virtual IP addresses that are utilized to access each cluster-configured resource.

9 Create a corresponding DNS name for each IP address you allocated in.
   You must enter the name of the cluster application into your DNS system. The DNS name is required to access the resources of the configured cluster.

10 Create a unique Active Directory account for your cluster service to run under.
    For best practices, set up a new account for cluster service user. The account must have local administrative rights and permissions on the cluster nodes. Ensure that the password for the account does not expire. (Follow your organization’s policies for password renewal.) It is strongly recommended that you do not use the same account for the cluster service and the applications in the cluster (for example, Microsoft SQL Server™). If you do use the same account, you may not be able to later change the cluster service password without disrupting your cluster applications.

11 Configure Microsoft Clustering Services on the first node.
   For more information on configuring Microsoft Clustering Services, see "Creating the Cluster" on page 33.
12 Modify the cluster network configuration.
For more information on modifying cluster network configuration, see "Modifying the Cluster Network Configuration" on page 34.

13 On the second node, use the iSCSI initiator to connect to the shared PS Series volumes.
Start the iSCSI initiator and log in to the iSCSI targets associated with the volumes you set up in step 1. Use the group IP address as the target portal or discovery address. Ensure that you have established a persistent connection to the volume and have bound the volume so that it is available when required. After the connection is established, the volumes appear as disks in the Disk Management utility.

**NOTE:** Do not align disk sectors or format the disk on the second node. It is important to verify that the disks on the second node are labeled *not initialized* (instead of *online*). This indicates that the SCSI reservation (to the first node) has been honored by the storage sub-system. Therefore, one node will not be able to corrupt data by writing to a disk that has been reserved by another node. See "Connecting Nodes to Volumes" on page 29 for more information.

14 Add a second node to the cluster.
For more information on adding a second node, see "Adding a Node to the Cluster" on page 37.

15 Consider modifying cluster configuration options.
For more information on modifying cluster configuration options, see "Modifying Cluster Configuration Options" on page 39.

16 Test the cluster.
For more information on testing a cluster, see "Testing Cluster Failover" on page 39.
Setting Up the Dell|EqualLogic PS Series SAN

The following sections describe how to create a Dell|EqualLogic PS Series group, create volumes, and restrict access to the volumes.

Creating the Group

Use the Group Manager GUI or CLI to manage a group. Access the GUI from a web browser by connecting to the group IP address. Access the CLI from a telnet or ssh connection to the group IP address or a serial connection to a group member. After you have established a connection to the group, log in to an administration account such as grpadmin. The following list of documentation is available on the EqualLogic Customer Support web site.

- For detailed information about setting up PS Series storage array hardware and getting started with a group, see the PS Series QuickStart.
- For detailed information about volume setup and advanced group management using the graphical user interface (GUI), see the Group Administration manual.
- For more information about using the command line interface (CLI) to manage a group and individual arrays, see the CLI Reference manual.
When creating a group and configuring arrays as group members, ensure the
you have:

- Choose the group RAID level that is optimal for your application
  performance. Before creating a PS Series group, you should determine
  which RAID level. To configure on the group members (storage arrays) you
  can choose from RAID 5, RAID10 and RAID 50.

  **NOTE:** Both the RAID levels provide adequate performance and fault
  tolerance for data volumes.

  For more information on RAID levels in a PS Series group, see the
  technical report *Understanding Group RAID Levels* on the EqualLogic

- You must configure at least two network interfaces on each group member
  in order to configure multipath I/O. For example, connect one network
  cable to the eth0 interface and another network cable to the eth1
  interface. Then, connect the cables to different switches. Then, use the
  Group Manager GUI or CLI to configure each interface.

After the group is configured, you can create volumes and then access the
volumes from the cluster nodes.

### Configuring Volumes in a PS Series Storage Array

You can use the Group Manager GUI or CLI to create volumes. To use the
GUI, connect to the group IP address from a web browser and log in to an
administration account, such as `grpadmin`. The *Group <groupname>*
windows appears, where *groupname* is the name of group you are configuring.
Click and expand items in the far left panel of the GUI for detailed
information about group components. Tasks such as creating volumes are
shown in the *Activities* panel.
Create the following shared volumes:

- One volume that is dedicated for use as the cluster quorum resource. Microsoft requires that you configure the quorum disk with a size of 512 MB.
- One or more volumes for application data (that is, service data).
- Optionally, a VSS control volume if using Auto-Snapshot Manager, or volumes for disk backup media.

To ensure proper security and data integrity, for each shared volume, create one or more access control records to allow only the cluster nodes access to the volume. Also, reserve snapshot space if you want to create volume snapshots or use Auto-Snapshot Manager.
To create a volume:

1. Click Create Volume in the Group Summary window. The Create Volume window appears, as shown in Figure. Enter a unique volume name and the volume size. Optionally, reserve snapshot space for the volume. The Space Utilization table shows the current group capacity and the capacity with the new volume.

![Figure 4-2. Group Manager - Create Volume](image)

It is recommended that you select meaningful volume names such as cluster1-quorum for the quorum volume, cluster1-data1 for a service volume, and cluster1-test for a testing volume. This helps to eliminate confusion if you have multiple clusters attached to the same PS Series group.
2 Click Next to display the window that enables you to set up an access control record for the volume, as described in "Restricting Access to Volumes" on page 25.

   **NOTE:** You can create and modify access control records for a volume at any time.

3 After you specify the access control information, click Next, confirm the volume configuration, and then click Finish to create the volume.

   The volume should appear when you expand Volumes in the far left panel of the GUI. Select the volume name to display volume details. After you create a volume, an iSCSI target name is automatically generated for the volume. The PowerVault NX1950 storage system connects to the volume through the group IP address and the target name.

---

### Restricting Access to Volumes

All nodes in a cluster must have access to the shared storage (for example, the quorum volume and service volumes). A PowerVault NX1950 storage system that is not in the cluster must not have access to the volumes. The cluster software ensures that only one cluster node can access a given volume at a time.

Access control records are used to restrict host access to volume data in a PS Series group. A group volume and its snapshots share a list of access control records (sometimes called the access control list). You can configure a record to apply to the volume, its snapshots, or both, as needed.

When you create a volume with the GUI or CLI, you can create an access control record at that time. You can also create and modify access control records at any time.

For example, in the GUI:

1. Expand Volumes in the far left panel of Figure 4-1 and select the volume name.
2. Click the Access tab in the window that appears, and then either click Add or select an existing record and click Modify. The Modify Access Control Record window appears as shown in Figure 4-3.

   In each access control record, you can specify an IP address, iSCSI initiator name, or CHAP user name (or any combination).

   **NOTE:** A cluster node must match all the requirements in one record in order to access the volume or snapshot.
The most secure way to control access to your volumes is to use a combination of IP address and CHAP, as shown in Figure 4-3. For example, if a record includes both an IP address and a CHAP user name, the PowerVault NX1950 cluster solution must present the IP address, the CHAP user name, and its associated password (using the iSCSI initiator) to match the record. If a record includes a CHAP user name only, the initiators that support discovery unsuccessfully try to connect to the volume, increasing event log activity. You can also specify whether the record applies to the volume, the volume snapshots, or both.

**NOTE:** If you use IP addresses or iSCSI initiator names to restrict access, create an access control record for each IP address or initiator name in the PowerVault NX1950 storage system. For example, if a PowerVault NX1950 storage system has two NICs that are handling iSCSI traffic, create two records, one with the IP address assigned to one NIC and the other with the IP address assigned to the other NIC. This ensures that the PowerVault NX1950 cluster solution can access the volume (or snapshot), regardless of which NIC is used for the connection.
NOTE: You must configure CHAP in the group to use CHAP to restrict host access to volumes. For more information, see the PS Series Group Administration manual.

4 After you specify the access control information, click OK to create the record. Verify that the record appears in the Group Manager Volume Access window, as shown in Figure 4-4.
Configuring Shared Storage on Your Dell|EqualLogic PS Series Storage Array

The following sections describe how to connect nodes to the Dell|EqualLogic PS Series volumes, align disk sectors for optimal performance, create a basic disk, and assign a drive letter. Although all cluster nodes must be connected to the shared volumes, you only have to align disk sections and format the disks on the first node in the cluster.

Connecting Nodes to Volumes

After Microsoft® iSCSI Initiator is installed on a cluster node, you can connect the node to the shared volumes, including the quorum resource volume and the service volumes. A volume is seen on the network as an iSCSI target. When you create a PS Series volume, the group automatically generates an iSCSI target name. The volume name is appended to the end of the target name. After the initiator logs into the volume, it appears as a local disk (called an iSCSI disk) in the Disk Management utility.

**NOTE:** To access a volume, a node must supply an IP address, iSCSI initiator name, or CHAP user name that matches the information in one of the volume's access control records. For more information, see “Restricting Access to Volumes” on page 25.

The following steps describe how to connect to a PS Series volume:

1. Launch the Microsoft iSCSI initiator. Click Start Programs → Microsoft iSCSI Initiator → Microsoft iSCSI Initiator.

2. In the iSCSI initiator Properties screen, click the Discovery → Add. In the Add Target Portal screen, specify the PS Series group IP address (or its DNS name). Then, click OK. This enables the initiator to discover the iSCSI targets associated with the group volumes.

3. In the Microsoft iSCSI Initiator Properties window, click the Targets tab.
4 Select the desired iSCSI target and click Log On. In the Log On to Target window, check the box next to **Automatically restore this connection when the system reboots**.

5 Perform step 4 on all the nodes in the cluster.

6 If you want to use multipath I/O, in the Log On to Target window, check the box **Enable multi-path** and then click **Advanced**. This enables you to specify multiple physical paths to the same target.

For more information about configuring multipath I/O, see the EqualLogic technical report *Deploying Microsoft Windows Server 2003 MPIO® in an iSCSI SAN*.

**Figure 5-1. Single Interface Log On and Multipath I/O Log On**

7 If the volume requires CHAP credentials, in the Log On to Target window, click **Advanced**. The **Advanced Settings** window appears as shown in Figure 5-2. Check the box next to **CHAP logon information** and specify the required user name and secret (password). The information must match an access control record for the volume and an entry in a CHAP database set up in the group or on an external Remote Access Dial-In User Server (RADIUS). After entering the information, click **OK**.
In the Log On to Target window, click OK to complete the login.

Confirm the connection by clicking the Targets tab in the Microsoft iSCSI Initiator Properties window. The target should appear in the list with the status Connected.

In the Microsoft iSCSI Initiator Properties window, click the Bound Volumes/Devices tab. To ensure that the volume is available when the iSCSI service is started by Windows, click Bind All → OK.

After the node is connected to a volume’s iSCSI target, it appears as a local disk (iSCSI disk) in the Disk Management utility.
Aligning the Disk Sectors

For optimal performance with PS Series volumes, it is recommended that you configure the volume disk partitions to begin on sector boundaries that are divisible by 64K (that is, evenly divisible by 65536 bytes or 128 sectors). This makes the sectors match the default PS Series storage array RAID stripe segment size and improve volume and overall group performance.

**NOTICE:** Use the diskpart utility in the Windows 2000 Server Resource kit to align the disk sectors. Do not use the Windows Unified Data Storage Server 2003 utility diskpart to align disk sectors on a PS Series volume, because you do not achieve the desired results.


Configuring a Basic Disk

When you perform the disk sector alignment procedure, as described in "Aligning the Disk Sectors" on page 32, the default action creates a basic disk.

**NOTE:** Do not convert the disk to a dynamic disk. Dynamic disks are not supported with iSCSI volumes.

Assigning a Drive Letter and Formatting a Partition

After you have aligning disk sectors and created a basic disk, the new volume is seen in the Disk Management utility as On-Line and Healthy. A disk associated with a connected PS Series volume is referred to as an iSCSI disk.

**NOTE:** Although you can create multiple disk partitions on an iSCSI disk, it is recommended that you only use one partition. For details on assigning a drive letter and formatting an iSCSI disk, see the technical report *Deploying Microsoft Windows Server 2003 in an iSCSI SAN* on the EqualLogic Customer Support website at [www.equallogic.com](http://www.equallogic.com).
Setting Up MSCS

The following sections describe how to implement a two-node cluster that uses Dell|EqualLogic PS Series storage. Before you begin, ensure that:

- You have the PS Series group and volumes setup; the Microsoft® Windows® Unified Data Storage Server 2003 operating system configured on the cluster nodes; and the nodes connected to the shared volumes.
- In addition, you should have implemented network redundancy for your public-facing nodes, as described in the section "Planning Network Redundancy" on page 15.

Creating the Cluster

Follow these steps to set up Microsoft clustering:

1. On the first node (Node A), click Start→Programs→Administrative Tools→Cluster Administrator. Alternatively, use cluadmin.exe from the command line or click Start→Run→cluadmin.exe.

2. In the Cluster Administrator, select Create new cluster. The New Server Cluster Wizard that guides you through the steps of setting up your cluster. Click Next.

3. Select the domain that you want the cluster to be a part of. If you have more than one domain, you can select it from the Domain drop-down menu. Specify a unique name in the Cluster Name field. Click Next.

4. Specify the computer that is the first node in the cluster. You can use the Browse button to select a server other than the one you are installing from. Click Next.

5. The Cluster Wizard performs an analysis of the node you specified in order to verify the feasibility of the installation. If there are no errors reported, click Next.

6. Specify the IP address that is used to connect to your cluster. Click Next.

7. Specify the cluster service account user name and password that you set up in step 11 in "Setting Up the Cluster" on page 17 and click Next.

8. A window with the proposed cluster configuration appears. Scroll down and verify your choices and click Quorum.
In the Cluster Configuration Quorum window, specify the iSCSI disk associated with the PS Series volume you configured for the quorum resource and click OK. When the Proposed Cluster Configuration window appears again, click Next.

The PowerVault NX1950 cluster system is created on the node you specified in Step 4. If the Cluster Wizard finds any errors, a condition is flagged. You can expand the failed object to obtain the details required to correct the issue. Click Next to continue if you do not have any critical errors that prevent the cluster from completing the configuration.

NOTE: If you are using DHCP, you may receive a warning, as shown in the figure below, that one or more network adapters are configured to use DHCP. Although the cluster performs with a network adapter set to use DHCP, it is not recommended.

After the cluster configuration is complete, the Cluster Wizard enables you to view the log. Click Finish to exit the wizard.

Modifying the Cluster Network Configuration

After the cluster installation is complete, the Cluster Administrator displays all the objects that were automatically created. You must make configuration changes that are specific to your cluster environment to the network object.

To modify the cluster network configuration:

1. In the left panel, expand Cluster Configuration and click Networks. The network adapters active on the node appears in the right panel as shown in Figure 6-1.

Figure 6-1. Cluster Administrator - Networks
2 Right-click each network object in the right panel and select Properties.

3 Select the network option button that describes the function of the network adapter. If an adapter does not participate in the cluster, ensure that you have unchecked the box Enable this network for cluster use as shown in Figure 6-2. If the adapter fails, the cluster treats it as cluster failure and fails over the services to another node. Therefore, it is necessary that you perform step 3. Click OK when finished.

Figure 6-2. Network Object- Properties

4 Reorder the bind preference on the network adapters of the cluster node. Use the following order:
   a  External public network
   b  Internal private network (Heartbeat)
   c  SAN network

On the node, click Start → Control Panel → Network Connections. From the menu bar, select Advanced → Advanced Settings. Use the arrow keys on the right to reorder the adapter list, as shown in Figure 6-3.
5 If you are using multipath I/O, in the Cluster Administrator, right-click the network name that represents your SAN network and select Properties. If you are not using multipath I/O, you have completed the network configuration modifications.

In the Network Properties window, uncheck Enable this network for cluster use option. This allows multipath I/O to control the link failover for the SAN interfaces.

NOTE: If all the redundant network connections fail on the node that is controlling the cluster, services fail over to another node. This is because the cluster cannot reach the backend of the PS Series storage.

It is recommended that you test multipath I/O failover. On a cluster node, unplug one of the network cables that connects to the SAN network. The connectivity to the PS Series storage array should not be lost.
Adding a Node to the Cluster

After you complete the initial cluster setup on the first node (Node A) and modify the cluster network configuration, you must add at least one other node (Node B) to the cluster to create a failover partner. Windows Unified Data Storage Server 2003 allows you to have up to eight nodes in one cluster, when using iSCSI disks for shared storage. The node must be connected to the shared volumes, as described in "Connecting Nodes to Volumes" on page 29. However, do not align disk sectors or format the disks.

To add a node to your cluster, follow these steps.

1. Using the Cluster Administrator, click File → New → Node. This launches the Add Nodes Wizard. Click Next to continue.

2. In the Select Computers window, specify the node you want to add to the cluster in the Computer name field. You can either type the name or click Browse to locate the node. After you specify the node, click Add to move it into the Selected computers list. Then, click Advanced.

3. In the Advanced Configuration Options window, select Advanced (minimal) configuration to specify that the new node (Node B) should not connect to the resources. Then, click OK to return to the Select Computers window and click Next.

4. The Add Nodes wizard analyzes the node configuration, displaying progress as shown in Figure 6-4. If errors are found, a condition is flagged. You can expand the failed object to obtain the details needed to correct the issue. If there are no critical errors that prevent the wizard from continuing the configuration, click Next.
5 In the Cluster Service Account window, enter the password for the cluster service account that you specified for the first node in step 7 of "Creating the Cluster" on page 33. The User name field is populated and cannot be changed. Click Next to continue.

6 The Proposed Cluster Configuration window appears. Review the configuration. Click Next to continue.

7 The wizard begins to add the node to the cluster. The Adding Nodes to the Cluster window appears, showing the progress. If errors are found, a condition is flagged. You can expand the failed object to obtain the details needed to correct the issue. If no errors occur that would prevent the wizard from completing the configuration, click Next to continue.
8 After the wizard completes the new cluster node configuration, the wizard notifies you that the addition was successful and give you the option to view the log. To exit, click Finish.

9 As described in step 4 of Modifying the Cluster Network Configuration, reorder the bind preference for the new cluster node’s network adapters. Use the following order:

a External public network
b Internal private network (Heartbeat)
c SAN network

On the new cluster node (Node B), click Start → Control Panel → Network Connections. From the menu bar, select Advanced → Advanced Settings. Use the arrow keys on the right to reorder the adapter list.

**Modifying Cluster Configuration Options**

Microsoft recommends the following:

- Specify the preferred owners of a cluster group.
- Specify the restart policy for a resource.
- Specify which nodes can own a resource.

These options are unique to every cluster implementation. For detailed information, see the Microsoft TechNet article *Planning and preparing for cluster installation* which can be found at the following location: www.microsoft.com

**Testing Cluster Failover**

It is recommended that you ensure that cluster services can fail over in the event of a failure. To test the cluster, use the Cluster Administrator to move resource groups from one node to another. Perform the following steps using the Cluster Administrator:

1 Expand Groups in the left panel.

2 Select the first group object. The node that owns the object appears in the right panel.

3 Right-click the first group object and select Move Group, as shown in Figure 6-5.
If the failover succeeds, the Cluster Administrator displays the change of owner in the right panel, as shown in Figure 6-6.

Figure 6-6. Cluster Administrator

Repeat step 1 to step 3 for each group object. You can also verify your cluster setup with the Cluster Diagnostics and Verification Tool ClusDiag.exe available on the Microsoft website at www.microsoft.com/downloads/. 

Figure 6-5. Cluster Administrator - Move Group
Expanding Your SAN Storage

You can easily expand individual Dell EqualLogic PS Series volumes and SAN capacity, online and without disruption. You can increase the size of a PS Series group volume by using the Group Manager GUI or CLI. You must then enable Microsoft® Windows® operating system to recognize the size change.

The following section gives you information about increasing SAN capacity to accommodate new volumes or expanded volumes. You can add more members to the PS Series group. For more information, see "Increasing PS Series Group Capacity" on page 43.

Increasing the Size of a PS Series Volume

You can use the Group Manager GUI or CLI to increase the size of a PS Series volume without disrupting users. You do not have to reboot the Dell™ PowerVault™ NX1950 system, and the space is immediately available. Follow these steps to use the Group Manager GUI to increase the size of a volume:

1. Expand Volumes in the far left panel, and select the volume name.
2. In the Activities panel of the window that appears, click Modify volume settings. In the Modify Volume Settings window, verify that the Free group space displayed in the space utilization table is larger than the desired expansion size.
3. Specify the new volume size, as shown in Figure 7-1 and click OK.
To enable Microsoft Windows Unified Data Storage Server 2003 to recognize the volume size increase, you must re-scan the disks in the Disk Management utility and then use the DiskPart utility. For more information, see the technical report Microsoft Windows: Expanding Basic Disk Volumes on the EqualLogic Customer Support website at www.equallogic.com.

NOTE: In a cluster environment, when you expand iSCSI disks, you must run the DiskPart utility from the cluster node that is controlling the cluster. Standby cluster nodes report iSCSI disks as Unknown and Unreadable as they do not have control of the disk resource. However, the Standby nodes still see the volume as extended.
Increasing PS Series Group Capacity

If additional PS Series group storage capacity is needed in order to create more volumes or expand volumes, you can add more members (arrays) to the group:

1. Set up the hardware for the new PS Series storage array.
2. Run `setup`. When prompted for the PS Series group to join, specify the group name and IP address. For complete array setup and member configuration instructions, see the PS Series QuickStart or the Group Administration manual.
3. After the array has been added to the group, volume data is load-balanced across all the group members and the group capacity expanded. You can then add new volumes or increase the size of existing volumes.
Strategies for Backup and Recovery

You can use the backup and recovery solutions available with the Dell EqualLogic to ensure high availability for your Dell™ PowerVault™ NX1950 cluster solution. The following sections address these areas and present possible solutions.

Protecting Cluster Data

There are four specific areas to protect with backups to ensure high availability for your cluster nodes:

- **Cluster disk signatures and partitions.**
  Before you begin to backup any data on the cluster nodes, make sure you backup the cluster disk signatures and partitions using the **Automated System Recovery** in the Backup Wizard for Windows. If you have to restore the signature of the quorum disk later, it is critical to have a copy from which to restore. For example, you must restore the signature of the quorum disk if you experience a complete system failure and the signature of the quorum disk changed since the last backup.

- **Cluster quorum resource.**
  When you backup data on a cluster node, make sure you also backup the quorum resource. The quorum resource is important because it contains the current cluster configuration, application registry checkpoints, and the cluster recovery log.

- **Shared disks.**
  To back up all shared disks owned by a node, perform a full backup from that node. If a shared disk owned by the node that is being backed up fails over to another node during the backup process, the backup set does not contain a full backup of that disk.

- **Data on the individual cluster nodes.**
  After you back up the quorum resource on one node, it is not necessary to back up the quorum resource on the remaining cluster nodes. However, you may want to back up the clustering software, cluster administrative software, system state, and application data on the remaining nodes.

**NOTE:** If you back up the system state for a node, you also automatically back up the quorum data if the cluster service is running on that node.
Choosing a Backup Method

There are many ways to backup cluster data. For example, you can follow the steps in the Microsoft TechNet article *Backing up and restoring server clusters* to backup cluster data using the Microsoft Backup utility, NTBackup. For more information, see Microsoft documentation.

Alternately, to backup cluster data, you can use a backup application from the vendor of your choice. Consider the following when choosing a backup application:

- Verify that the backup application is capable of acting as a VSS requestor, so you can use the VSS backup feature. Backup applications that support VSS and can be used as a VSS requestor include CommVault® Galaxy® Backup & Recovery.

- The Cluster backup software should be *cluster aware*. The software should use cluster APIs and be able to deal with the failover of a disk resource during the backup process.

- Ensure that your backup application is compatible with the version of the Windows operating system installed on the cluster nodes. Another method of protecting Windows Unified Data Storage Server 2003 data is by using a near-continuous backup and archiving solution that unifies data protection, disaster recovery, and archiving. This type of solution provides immediate recovery, file, e-mail, or, database storage optimization, instant user access, and regulatory compliance in a Windows Unified Data Storage Server 2003 environment. You can maintain copies of the Windows Unified Data Storage Server 2003 data on a separate server and continuously update these copies as the data changes. If a catastrophic failure occurs, the data loss is zero or at most a few minutes.

Backup applications that support near-continuous backup and archiving fall under different categories and include Microsoft Data Protection Manager (DPM). DPM is a server software application that optimizes disk-based backup and recovery. It provides continuous data protection for file servers.
Restoring Data

When restoring cluster data, focus on the following components:

- Cluster database—If the signature of the quorum disk has changed since you last backed up data, instead of restoring the System State only, use Automated System Recovery in the Backup or Restore Wizard to restore the quorum disk signature along with the System State.

  Follow the recommended Microsoft procedure described in the TechNet article Restore the cluster database on a local node on the Microsoft website at www.microsoft.com.

- Quorum resource—Before restoring the data, you must stop the cluster service on all remaining cluster nodes after the node that was restored reboots. The entire cluster is therefore unavailable while the restored quorum data is copied to the quorum disk and the other nodes in the cluster.

  Follow the recommended Microsoft procedure described in the TechNet article Restore the contents of a cluster quorum disk for all nodes in a cluster on the Microsoft website at www.microsoft.com.

- Cluster node volumes—Using your backup application, perform a restore of the required data. There are many options you can use to restore data. You can restore from a snapshot, restore from a tape, or restore from backup-to-disk media. Choose the option appropriate for your situation.

  For more information see, the EqualLogic Customer Support website at www.equallogic.com.
Upgrading your SAN and Network

A properly configured cluster does not have shared hardware components. This enables you to recover from the failure of almost any component in your cluster configuration. However, you may encounter a situation where you have to upgrade some component of your cluster like a cluster node, a component in a node, or a segment of a network.

Upgrading Components in Your Cluster

When you upgrade a component in your Dell™ PowerVault™ NX1950 cluster node:

1. Use the Cluster Administrator to determine if the node has control of the cluster resources. If the node has control of the cluster resources, use the Cluster Administrator to fail over the resources to another node.

2. After you have moved the resources from the node, pause the node. At this point, you can safely perform work on that node.

Use this same process if you are performing maintenance on a network switch, because a switch failure is equivalent to a link failure.

You may also be required to update the firmware on the Dell|Equallogic PS Series storage arrays in the group. When updating firmware on an array, you must restart the array. This causes a service interruption for any application using the volumes stored on the array, because the volumes is unavailable for the time that it takes the array to restart. For detailed information about updating PS Series, see the PS Series firmware Release Notes.
Maintaining Your Cluster

The following sections describe two common cluster maintenance issues, how to replace a quorum disk that has failed and how to remove a node from your Dell™ PowerVault™ NX1950 cluster solution.

Replacing the Quorum Resource

If access to the shared quorum resource fails or if the Dell|Equallogic PS Series volume associated with the quorum resource fails, the cluster crashes. Although the cluster service attempts multiple restarts, the cluster does not respond until the resource is replaced.

You can replace a failed quorum disk using the following procedure:

1. In the PS Series group, create a new volume for the quorum resource. Apply the same access control record settings as for the failed quorum volume. For more information, see "Configuring Volumes in a PS Series Storage Array" on page 22.

2. On each cluster node, set the cluster service to manual to prevent repetitive restarts.

3. On the first node (Node A), use the iSCSI initiator to log in to the new quorum volume. Ensure that you make the connection persistent and to bind the connection. For more information, see"Connecting Nodes to Volumes" on page 29.

4. Align the disk sectors, as described in "Aligning the Disk Sectors" on page 32, and configure as a basic disk, as described in "Configuring a Basic Disk" on page 32.

5. On Node A, using the Disk Management utility, create a single NTFS partition on the new quorum disk and assign a different drive letter from that of the original quorum resource. For more information, see "Assigning a Drive Letter and Formatting a Partition" on page 32.

6. On Node A, open a command prompt and start the cluster service in fixquorum mode, using the net start command:

   `net start clussvc /fixquorum`
7 After the cluster service has started on Node A, launch the Cluster Administrator and connect to Node A. Do not connect to the cluster alias name. Open the Cluster Administrator and click File→Close. Performing this action disconnects you from the cluster virtual name.

8 Connect to Node A by clicking File→Open Connection.

9 In the Open Connection to Cluster window, enter the node name in the Cluster or server name field.

10 On Node A, within the Cluster Group, create a new physical disk resource using the new quorum resource created in step 1. Bring this disk online.

11 On Node A, in the Cluster Administrator, perform the following steps:
   a Right-click the cluster name and select Properties. Ignore the error messages concerning the failed quorum partition.
   b Click the Quorum tab and, from the Quorum resource pull-down menu, select the new iSCSI disk for the quorum resource and apply the changes.

12 On Node A, stop the cluster service.

13 On the second node (Node B), use the iSCSI initiator to log in to the iSCSI target for the new quorum resource. Remember to make the connection persistent and to bind the connection.

14 Starting with Node A, restart the cluster service on both nodes.

15 On Node A, from the Cluster Administrator and within the Cluster Group, delete the old quorum resource.

16 On Node A and Node B, set the cluster service to automatic.

Removing a Node from a Cluster

To remove a node from a cluster:

1 Start the Cluster Administrator.

2 Right-click the node you want to remove and click Stop Cluster service.

**NOTICE:** Do not perform this step if the PowerVault NX1950 storage system is the last node in the cluster.
To remove the last node from a cluster:

1. Right-click the node you want to remove and click **Evict Node**, as shown in Figure 10-1. This returns the cluster to its original state. You can add it again later to the same cluster or to a different cluster.

**Figure 10-1. Cluster Administrator- Evict Node**

If you cannot start the cluster service or if you have trouble removing the node, you can manually un-configure the cluster service on a node as follows:

1. On the node you want to remove, open a command prompt. Click **Start** → **Run** and enter `cmd`.

2. At the command prompt, enter `cluster node <nodename> /forcecleanup`.

**NOTE:** If the cluster service does not exist in the registry, the command does not respond. To create a place holder, enter `sc create clussvc` at the command line.
Microsoft® released the Microsoft Windows Server® Resource Manager (WSRM) as a feature in Microsoft Windows® Unified Data Storage Server 2003 operating system. By using WSRM to manage a cluster deployment, you gain more control over node resource usage during failover. In addition, depending on specific events or the current state of the cluster, you can also use WSRM to activate specific resource allocation policies. The use of WSRM is outside the scope of this document.

For more information on WSRM, read the Microsoft Download Center article Using WSRM and Scripts to Manage Clusters on the Microsoft website at www.microsoft.com.
Migrating an Existing Cluster to Dell|Equallogic PS Series Storage

If you are modifying your existing Dell™ PowerVault™ NX1950 cluster implementation with the Dell|Equallogic PS Series storage array, you must migrate data from an e-mail store, relational database, or file share to a new shared storage device. When moving an existing cluster:

1. **Create a back-out plan**—The first step in any migration is to have a back-out plan in place. If your migration fails, you must be able to bring the old system back online to service your customers or users. Planning and documenting how you are reverting back to the old system gives you the best chance of a quick recovery.

2. **Perform a full backup of your data on the existing cluster**—As with any mission critical application that has its configuration modified, it is strongly recommended that you perform a complete backup of all data, databases, and logs before migrating to a new system or cluster.

3. **Copy the existing cluster data from the current storage to volumes in a PS Series group**—When performing the migration, you should have exclusive access to the data, databases, and logs being moved. This helps in preventing open file locks. You can move data in several different ways. For example, you can:
   - Drag and drop files using Microsoft® Windows Explorer.
   - Backup to a tape library and restore to PS Series volumes.

   The method you use depends on the application data you are migrating. Moving a user file share is much simpler than migrating a large relational database. For more information about data migration, see the documentation located in the vendor application data repository.

4. **Bring the cluster online using the new data locations**—After you have successfully migrated your data, databases, or logs to the PS Series group, bring the cluster online by specifying the new location for the quorum resource and service data, as needed. Verify that all cluster groups and resources come online.
5 Test the cluster by performing the following steps:

   a  Test the application that is running on the cluster. This may include sending and receiving e-mail, writing transactions into a database, or reading and writing files to a network share. Verify that you can perform the same tasks using the data in the PS Series group as you did using the data in the previous location.

   b  Perform a failover test of the cluster from one node to another. Again, verify that all cluster groups and resources come online. A thorough test of your new cluster before putting it into production ensures a smooth transition.

6 Retain the old cluster data—If you prefer to leave the old storage infrastructure up and running for a period of time as a fallback measure you can store it so that the old cluster data may be accessible only to administrators.
Index

B
Backup and Recovery, 45

D
Dell|EqualLogic PS Series Storage
Migrating Data, 57
Dell|EqualLogic PS Series Storage Array
features, 9
Setup, 21

M
MSCS
Setup, 33

P
PowerVault NX1950 Cluster
Configuration, 7
features, 7
Setup, 17

Q
Quorum Resource, 51

U
Upgrading Components, 49

W
WSRM, 55